Crash Course: Microsoft Outlook
Microsoft Outlook is an incredibly powerful e-mail and personal information management application. Its features and capabilities are extensive. Refer to this handout whenever you require quick reminders for the best ways to maximize Microsoft Outlook.

Using Categories
Categories help you track, find, sort, filter, and group items (including messages, tasks, appointments, and contacts.
Categories can be a keyword or phrase.
If you don’t wish to use separate folders to organize e-mail, categories can help you track related items.
For example, you can assign each message a category, then locate all the e-mails pertaining to a specific project using Outlook’s Find feature.
- Click the Find button on the Standard toolbar to display Outlook’s Find feature and to display an Options button for calling Outlook’s Advanced Find menu.
Outlook’s Master Category List – accessed by clicking Edit | Categories - contains all available categories.
From the Master Category List, you can view categories, add new ones or delete those you no longer require.
- You can reset the Master Category List
  - Click the Master Category List and click Reset.
To assign an item to a category:
- Right-click it and select Categories.
- Select the category or categories and click OK to assign the item to the category/categories.
When you’re creating a message, you can assign it to a category by clicking the Options button from the Standard Toolbar and entering a Category.

Creating Customized Views
You can tailor the Outlook interface to your personal preferences.
Like Categories, customizing the user interface allows you to view messages and other Outlook items how you specify.
Outlook includes several handy features for tweaking default views - all are accessed and enabled from the View menu - to help you become more efficient and productive.
- The Navigation Pane (the Outlook Bar in older Outlook versions), new with Outlook 2003, provides shortcuts enabling quick access to various Outlook components, such as E-mail, Calendar, Tasks and Contacts.
  - Configure items you wish to view within the Navigation Pane by right-clicking the pane and selecting the checkboxes for the components you wish to display.
- The Reading Pane displays additional information for highlighted items and is easily configured.
  - Click View and highlight Reading Pane.
• AutoPreview, if selected, displays a few additional lines of information for e-mail and tasks.

Outlook supports other predefined views, which can be accessed by clicking View | Current View in older versions.

Beginning with Outlook 2003, users must click View | Arrange By | Current View to access predefined default views, including Messages With AutoPreview and Message Timeline.

Outlook also supports creating customized views:

- To customize display information, click View.
- Then click Arrange to display available sorting options, which include organizing messages and tasks by date, flag or subject, among others.
- Advanced customization features – such as formatting and field options - are available by clicking View | Arrange By | Custom.

### Address Books and Distribution Lists

- Contacts - and Personal Address Books in older Outlook versions - allow you to organize personal contact information and have it handy when needed, whether contacts are personal or professional.

In Outlook 2003, click Contacts on the Navigation Pane to view existing records.

Adding and updating contact information is straightforward:

- Just double-click a Contact to view or update it.
- Click the New button to create a new record.
- You can also drag-and-drop a Contact record received from someone else directly to Outlook.

The Personal Address Book and Contacts provide similar features.

- The Contacts list provides more advanced functionality, but both options enable tracking such basic information as name, address, telephone number and e-mail address.

- However, the Personal Address Book – usually stored in .PAB files within a user profile on the local hard drive - is being phased out in favor of Contacts.

- If you use several computers, you will only be able to access the Personal Address Book stored on each, whereas your Contacts list is usually stored on the network in client-server environments, thereby enabling you to access it from multiple locations.

- Distribution lists further extend the value of Contact lists; Distribution lists contain a group of individual e-mail addresses under a single name and simplify addressing a single e-mail message to a large number of people.

- Distribution lists also help ensure an intended recipient isn’t forgotten.

You can create distribution lists for a small group of people or for hundreds or thousands.

To create a distribution list:

- Click the drop-down arrow on the New button from Outlook’s Standard Toolbar.
- Select Distribution List.
Manage Contacts

- Outlook provides a number of different views – accessed by clicking Views | Current View - and sort options to help list Contact information.
- In addition to the default Address Card view, you can also display Contacts with these default views:
  - Detailed Address Cards
  - Phone List
  - By Category
  - By Company
  - By Location
  - By Follow-up Flag
- You can also use Outlook to link other items - such as meeting requests, journal entries and tasks - to a Contact; To view these options:
  - Right-click a Contact.
  - Select the item you wish to use from the resulting pop-up menu.
- Sharing Contacts with co-workers and business associates saves time and helps eliminate errors.
- Outlook supports sending and receiving Contacts directly through e-mail:
  - Just drag-and-drop a Contact to an e-mail message to include it as an attachment.

Filtering Messages

- You can filter messages in Outlook using criteria you specify.
- You can also create rules to automatically move messages to specific folders.
- Microsoft introduced a new Junk Mail Filter with Outlook 2003, which helps further reduce clutter.
  - The feature is useful for filtering junk mail and other spam.
  - To enable the Junk Mail Filter:
    - Click Tools and select Options.
    - Click the Junk E-mail button.
    - Set your desired filtering level.
- Four other tabs are available for helping manage junk e-mail:
  - Safe Senders - If messages placed in the Junk Mail folder are mistakenly marked as spam, you can add the sender to your Safe Senders List using the Safe Senders tab.
Safe Recipients - Rely on the Safe Recipients tab to add addresses or domain names that should not be treated as junk mail. The Safe Recipients List can prove particularly beneficial if you subscribe to several mailing lists.

Blocked Senders - Use the Blocked Senders tab to add sender e-mail addresses and domain names that should be blocked from sending you e-mail.

International – Use this tab to specify how to handle messages written in other languages.

You can also associate individual e-mail messages with each option by right-clicking the e-mail message within your Inbox, selecting Junk Mail from the pop-up menu, and specifying which list the sender should be added to.

Creating Custom Filters

Prior to Outlook 2003, the Define Views dialog box is used to configure filters. In older versions, click View, select Current View, select Customize Current View and click the Filter button to create a wide variety of filters making it easier to organize your e-mail.

To create a customized filter in Outlook 2003:

- Click View.
- Select Arrange By.
- Click Custom.
- Select the Filters button. Doing so opens the Filter dialog box.
- Provide the information you wish the filter (using the additional tabs if necessary) to use.
- Click OK to create the filter.

Outlook rules – accessed by clicking Actions, Rules Wizard and Tools, Rules Wizard in older versions or Tools, Rules And Alerts beginning with Outlook 2003 – allow you automatically assign certain actions to e-mails meeting specific criteria.

To create a rule in Outlook 2003:

- Click Tools.
- Select Rules And Alerts.
- Click the New Rule button to start the Rules Wizard, which will walk you through the process of creating a customized rule.

Automatic Responses

You can configure Outlook to automatically respond to messages.

While automatically responding to all e-mail is generally considered poor e-mail etiquette, configuring automatic responses to specific messages can save you time and at least give the sender confirmation that the message was received.

Use Rules And Alerts to create tailored responses to specific message scenarios.

A myriad number of customization options are available.

The Rules Wizard will walk you through the process of creating automated responses.
When using the Rules Wizard, look for the Reply Using A Specific Template or Have Server Reply Using A Specific Message options to send customized messages in response to specific messages.

Outlook supports various other automated response options; For example, if you wish to configure automatic responses for each meeting invitation you receive:

- In older versions of Outlook, open the Tools menu.
- Select Options.
- Click the Preferences tab.
- Click the Calendar Options button (beginning with Outlook 2003, you need to then click the Resource Scheduling button). You can then configure the following automatic response options:
  - Automatically accept meeting requests and process cancellations
  - Automatically decline conflicting meeting requests
  - Automatically decline recurring meeting requests

Outlook’s Out of Office Assistant helps alert colleagues and coworkers to special circumstances, such as when you’re on vacation.

To enable the Out of Office Assistant:

- Click Tools.
- Select Out of Office Assistant.
- Select the I Am Currently Out Of The Office radio button.
- Type a descriptive message.
- Click OK.

Security

As e-mail messages travel through servers between you and the intended recipient, they are vulnerable to interception by hackers.

In order to prevent others from reading your e-mails, or even doctoring them, you can use Outlook encrypt and digitally sign your messages.

The first step in sending a secure e-mail is obtaining the recipient's digital ID.

Recipients can send the digital ID to you in an e-mail containing their contact information.

You must also send your digital ID to intended recipients so they can receive and read your e-mail messages.

Once you’ve traded digital IDs you’re ready to exchange secure e-mails; to trade secure e-mail:

- Open a new message.
- Click View.
- Select Options.
- Click the Security Settings button to open the Security Properties dialog box.
- Select the Encrypt Message Contents And Attachments option.
- Click OK.
**Working with Tasks**

- Microsoft Outlook can replace bulky planners for coordinating to-do lists; Outlook’s Tasks feature makes it easy to track the things you have to do.
- You can change the default Tasks folder view by clicking View | Current View.
- Outlook offers numerous predefined Tasks views, including:
  - Simple List.
  - Detailed List.
  - Active Tasks.
  - Next Seven Days.
  - Overdue Tasks.
  - By Category.
  - Assignment.
  - By Person Responsible.
  - Completed Tasks.
  - Task Timeline.
- Tasks are highly customizable: you can mark Tasks completed, associate documents or files with Tasks, specify categories, makes notes, set a Task’s status, specify start dates and due dates, configure priorities and more.
- You can assign Tasks to others. To do so:
  - Click the Assign Task button on the toolbar
  - Address the task to the recipient as you would with an e-mail; the recipient will have the option of accepting the task or declining it.
- You can set reminders; Check the Reminder box and specify when you wish to be reminded the task is due.
- As you finish portions of an assigned task, you can use the drop-down menu – accessed by double-clicking the task – to specify the percentage of work completed.

**Faxing**

- Sending and receiving faxes in Outlook is an inexpensive way to work with faxed documents.
- Before you can send a recipient a fax, Outlook’s Fax Transport service must be installed or you must use a third-party fax service; the IT department manages these settings at work.
- In order for a recipient to receive a fax you send within Outlook, you must specify a fax number in the Business Fax field for the Contact; Adding the fax number creates an additional entry in the address list.
- To send a fax within Outlook:
  - Address the e-mail to the Business Fax entry.
  - Compose the message.
  - Attach any documents.
Send the message to send the fax to the recipient at the number provided in the Contact’s Business Fax field.

Receiving faxes in Outlook is more complicated.

When Outlook and the network are configured to receive faxes, fax messages will arrive in your Inbox as a regular e-mail, but the faxed document will be an attachment.

In order to read faxes, you require an additional fax-reading program; if a fax-reading program is loaded, faxed documents will open with that application.

Should you have trouble faxing within Outlook, contact the IT department.

Using Outlook Templates

Templates save you time and energy by allowing you to save a document in a generic format and then reuse the document to create subsequent e-mails.

Microsoft Outlook templates are saved with the .OFT file extension and are usually stored in the user profile Templates folder.

Traveling employees, whose profiles are stored on a network, can still leverage templates by saving the templates they use to their hard disks.

Creating a new template is relatively easy:

- Open a new e-mail message.
- Type the e-mail’s text (including subject line, greeting, salutation and signature).
- Save the message as a template by clicking File and selecting Save As.
- Selecting Outlook Template as the file type.
- Provide a file name for the template.
- Click Save.

To use a template:

- Click File.
- Select New.
- Click Choose Form.
- Select the User Templates In File System option from the Look In drop-down menu.
- Navigate to the location where the template is stored.
- Select the appropriate template.
- Click Open.

Using Outlook Forms

Outlook forms, like their template cousins, can save a tremendous amount of time by simplifying routine and repetitive business communications and centralizing updates.

To create a new form:

- Click Tools.
- Click Forms.
- Click Design A Form.
Select the type of form to create. To create a Message form, select Message.

Click Open. The design environment opens, displaying the standard Message form and the Field Chooser dialog box. At this point you can drag-and-drop items into the e-mail message, delete other items such as the Subject box, and create and edit new fields for your customized form. You can also specify the e-mail address where the e-mail should automatically be sent.

When you have finished designing the form, you must save your changes by clicking Save As and selecting Outlook Template from the Save As File Type drop-down box.

Provide a name for the form.

Click Save.

To make a form available to others, you must publish it:

Click Tools.

Select Forms.

Click Publish Form. You'll be prompted to provide a Display Name and Form Name before clicking Publish to complete the action.

To use a form:

Click Tools.

Click Forms.

Click Choose Form. Select the location where the form is saved.

Select User Templates In File System or Personal Forms Library from the Look In drop-down box to access forms saved on your system; select Organizational Forms Library from the Look In drop-down box to access the organization's published forms.

By default, Outlook saves new forms in the Personal Forms Library.

New forms will open in a new e-mail message.

Managing Folders

Creating folders is an easy way to group related e-mails in a single location; Folders provide logical storage locations for related Outlook data just as they do for regular files.

Creating Outlook folders is easy:

Simply click File.

Select New Folder.

Provide the new folder name.

Select a location within Outlook’s hierarchical structure.

Click OK.

Deleting folders is equally simple; You can either highlight the folder and press Delete or right-click the folder and select Delete.

Beware, though; When you delete a folder all of the information in the folder is also deleted.
Move folders by dragging-and-dropping them within Outlook’s hierarchical structure to a new location.
- You can also right-click a folder and select Move to open the Move Folder dialog box.
- When working with folders, it’s always a good idea to follow the less is more rule and avoid creating more than two layers of sub-folders.
- If you must use a very detailed hierarchy, use Categories to help you locate your messages.

**Using Delegates**
- Outlook supports sharing your Outlook information with other authorized users.
- You must make others delegates to share your Outlook information with them:
  - Click Tools.
  - Click Options.
  - Click the Delegates tab.
  - Click the Add button.
  - Select the person you wish to make a delegate. After selecting the delegate, the Delegate Permissions dialog box displays.
  - Select the appropriate permissions to grant the delegate.
  - Click OK.
- You can also share Outlook folders:
  - Open the folder’s properties by right-clicking the folder and selecting Properties.
  - Open the Permissions tab.
  - Add the individuals with whom you are going to share the folder’s contents.
  - Configure permissions for each individual or group by highlighting the individual group or individual and specifying the permission level using the drop-down box.

**Archiving E-mail**
- Almost all organizations limit Inbox size.
- Use Outlook Archive folders to store older messages you wish to save but don’t necessarily need stored in your online folders.
- The Outlook Archive folder stores your messages as text or HTML on your hard disk or in another location, thus freeing valuable network storage on the e-mail server.
- Because the Archive folder is stored on your computer’s hard disk, you should always back up the file.
- You can either write the file – archive.pst, which takes up much less space than stored e-mail information – to a network-based server (as opposed to the e-mail server) or copy it to removable media, such as a CD-ROM.
- In order to view the location of your archive file, click File | Archive.
- You can configure Outlook to archive your e-mail on a regularly basis using the AutoArchive settings – accessed by clicking Tools | Options.
AutoArchive settings are located on the Other tab.
AutoArchive allows you to specify the frequency of your archiving, as well as other options.
Unless you are vigilant about archiving every two or three weeks, it’s best to let AutoArchive do the job for you.

**Working Offline**
- If you travel frequently and want to access Outlook information when you aren’t connected to the e-mail server, you can configure a folder to contain the relevant information and make it available even when the computer is offline.
- Creating an offline folder requires more work than just creating an Outlook folder:
  - Beginning with Outlook 2003, highlight the folder in question and click File.
  - Select Work Offline and check or clear (depending upon your preference) the Prompt Me At Startup So I May Choose To Work Offline Or Online check box and click OK (if the check box is cleared, Outlook will automatically start offline if a server connection isn’t found).
- Click Yes to create the Offline Folder file.
- When you return to the office, you must synchronize your offline folders with the corresponding online versions.
- If you don’t synchronize, the online versions won’t reflect your changes and updates.
- You can manually synchronize folders by:
  - Highlighting the folder.
  - Clicking Tools.
  - Clicking Send/Receive.
  - Selecting This Folder.
- You can set Outlook 2003 to automatically synchronize by:
  - Selecting Send/Receive from the Tools menu.
  - Pointing to Send/Receive Settings.
  - Clicking Define Send/Receive Groups.
  - Specify a Send/Receive Group.
  - Specify the settings you wish for that group to use – being sure to select the Schedule An Automatic Send/Receive Every X Minutes check box within the Setting For Group “Your Group” section.

**Outlook Web Access**
- If you’re out of the office and need to keep up-to-date with events, Outlook Web Access allows you to use most any PC with Internet access to access Outlook using a standard Web browser.
- Just type in your organization’s Outlook Web Access URL and enter your username and password to access Outlook remotely.
The Outlook Web client boasts many features, including access to e-mail, tasks and your calendar; You’ll also find customizable toolbars, Help, and the Navigation Pane (the full functionality found will depend upon your organization’s Outlook Web Access implementation).

Use discretion when accessing the organization’s Outlook Web Access site: Sensitive information from your session, including user names and passwords, e-mail messages and more, can sometimes be accessed by other users.

It’s a good idea to avoid using public systems, such as those found in Internet cafes and libraries, for accessing Outlook Web Access.

New Features

Anyone who uses distribution lists will cheer the new feature enabling them to expand distribution lists and edit recipients before sending an e-mail.

This feature is easy to use:
- Click the plus sign next to the distribution list name and the list will populate the To field with all its members, enabling you to easily remove any individuals you need.

When Outlook 2003 and Microsoft SharePoint Services are configured for live documents, you can create a live attachment using Outlook 2003.
- The combination creates a Document Workspace within a SharePoint Services site.
- All recipients of an attachment, and other designated individuals, can open their own copy of the document and work on it.
- When changes to the document are saved, the changes are synchronized with those made by other authorized recipients.

New Mail Desktop Alerts is another new feature introduced in Outlook 2003.
- When enabled, new e-mail messages trigger small alert windows that appear in the bottom right corner of the screen regardless of which application you’re using at the time.

To enable New Mail Desktop Alerts:
- Click Tools.
- Select Options.
- Click the E-mail Options button.
- Select Advanced E-mail Options.
- Check the Display A New Desktop Alert (Default Inbox Only) check box.
  - Click OK to close the open boxes.
# Common Microsoft Outlook Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+F1</td>
<td>Toggle Navigation Pane.</td>
</tr>
<tr>
<td>Alt+F8</td>
<td>Open Macros dialog box.</td>
</tr>
<tr>
<td>Alt+F11</td>
<td>Open Visual Basic Editor.</td>
</tr>
<tr>
<td>Ctrl+1</td>
<td>Go to Mail.</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Go to Calendar.</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>Go to Contacts.</td>
</tr>
<tr>
<td>Ctrl+4</td>
<td>Go to Tasks.</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Go to Notes.</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>Go to Folder List.</td>
</tr>
<tr>
<td>Ctrl+7</td>
<td>Go to Shortcuts.</td>
</tr>
<tr>
<td>Ctrl+8</td>
<td>Go to Journal.</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all.</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Apply bold formatting.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected data to clipboard.</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Delete.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Forward message.</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Apply italic formatting.</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Create a new message.</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print the current element.</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Mark as read.</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Reply.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save.</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Mark as unread.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste clipboard contents.</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut data and paste to Clipboard.</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Open Go To Folder dialog box.</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo an action.</td>
</tr>
<tr>
<td>Ctrl+Alt+J</td>
<td>Mark Message as Not Junk Mail.</td>
</tr>
<tr>
<td>Ctrl+Alt+M</td>
<td>Mark to download message.</td>
</tr>
<tr>
<td>Ctrl+Alt+U</td>
<td>Unmark selected headers.</td>
</tr>
<tr>
<td>Keyboard Shortcut</td>
<td>Function</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Create Appointment.</td>
</tr>
<tr>
<td>Ctrl+Shift+B</td>
<td>Open Address Book.</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Create new Contact.</td>
</tr>
<tr>
<td>Ctrl+Shift+E</td>
<td>Create new folder.</td>
</tr>
<tr>
<td>Ctrl+Shift+J</td>
<td>Create Journal entry.</td>
</tr>
<tr>
<td>Ctrl+Shift+K</td>
<td>Create Task.</td>
</tr>
<tr>
<td>Ctrl+Shift+L</td>
<td>Create Distribution List.</td>
</tr>
<tr>
<td>Ctrl+Shift+N</td>
<td>Create Note.</td>
</tr>
<tr>
<td>Ctrl+Shift+P</td>
<td>Search folder.</td>
</tr>
<tr>
<td>Ctrl+Shift+Q</td>
<td>Create new Meeting Request.</td>
</tr>
<tr>
<td>Ctrl+Shift+R</td>
<td>Reply To All.</td>
</tr>
<tr>
<td>Ctrl+Shift+U</td>
<td>Create new Task Request.</td>
</tr>
<tr>
<td>Ctrl+Enter</td>
<td>Send message.</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Post in this folder.</td>
</tr>
<tr>
<td>Ctrl+Shift+V</td>
<td>Move to folder.</td>
</tr>
<tr>
<td>F1</td>
<td>Open Help or the Office Assistant.</td>
</tr>
<tr>
<td>F9</td>
<td>Send/Receive All.</td>
</tr>
<tr>
<td>Shift+F9</td>
<td>Send/Receive This Folder.</td>
</tr>
</tbody>
</table>